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Android Jones

Corel Painter 2023

Corel® Painter® 2023 is the ultimate digital art studio. Its inventive drawing tools, realistic brushes, cloning capabilities, and customizable
features let you expand your creative output in exciting new ways. When you use the pressure-sensitive brushes of Corel Painter, they
become fluid extensions of your hand, so the resulting brushstrokes are unrivaled in texture and precision. What's more, features such as the
ability to build your own Natural-Media™ brushes and customize how brushes interact with the canvas give you countless ways to develop
your artistic ideas. Corel Painter takes you far beyond what's possible in a traditional art environment.

Image created in Corel Painter. Artwork by Yann LeGuen
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What's new in Corel Painter 2023

Corel Painter takes you far beyond what's possible in a traditional art environment.

New! Fluid paint technology

Painter 2023 introduces an exciting new fluid paint brush technology. It offers Painter’s smoothest brush marks ever, with a bolder and more
revealing paper grain that's visible across the entire brushstroke. Highly adaptable, fluid paint brush marks can be built up slowly, with or
without overlapping, and provide a more natural painting and blending experience.

Beneficial for any artist specializing in concept, matte, comic, manga, anime, and other traditional media, fluid paint lets you control the
opacity of all brushstrokes applied to the layer. It also offers a more natural glazing capability, with exceptional levels of transparency and
opacity — from soft and muted to fully opaque.

You can enable fluid paint to work with any brush that uses Enhanced Cover methods, and it is compatible with Thick Paint. Fluid paint
technology also supports GPU acceleration on default layers for optimal brushing performance. For more information, see “Fluid Paint
controls.”
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You can use the Paint Opacity flyout on the property bar to access the most common Fluid paint controls.

New! Fluid paint brushes

You can dive right in to experience the new fluid paint technology by trying a brush variant from the Build and Sculpt or Paint and Blend
fluid categories.

With Build and Sculpt, you'll find a set of tools highly suitable for illustration, storyboarding, comic art, and manga. Ideal for blocking in
shapes or filling in color, these brushes lean on fluid paint’s ability to smoothly build up at lower opacity values. Some fluid variants are

perfect for revealing shape and structure, with enhanced grain rendering and a wet, oily feel, while others produce tighter, polished airbrush
marks.
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Sample brushstrokes from the new Build and Sculpt fluid paint brush category, including Hatch (left), Oil Sculpt (middle), and Shape Builder
(right).

With Paint and Blend, there are brushes with a more traditional feel, suitable for use by illustrators, fine art, and photo artists. These
variants paint smoothly in low opacities, and may feel wet or oily. They also blend with a range of subtly applying paint to heavily mixing
with the layer content. Many fluid brushes are configured with the improved ability to render paper grain.

Sample brushstrokes from the new Paint and Blend fluid brush category, including Brushy (left), Grainy (middle), and Dash (right).

To select a Fluid brush category and variant
1 In the toolbox, click the Brush tool ’/.

2 Click the Brush Selector on the Brush Selector bar.

3 Click a Fluid category, and click a brush variant.

New and enhanced! Fluid Papers

You can add new, high contrast paper textures to your artwork from the collection of 15 paper textures designed specifically to take
advantage of the expressive grain behavior of fluid paint.
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Fluid paint brushstrokes on the Standard Artist Canvas, Rough Gessoed Canvas, Mulberry Paper, and Carbon Fiber papers (clockwise from
top left).

To apply a Fluid paper texture
1 On the property bar, click the Paper Selector flyout button [

2 Scroll through the Paper Textures area and click a paper texture swatch in the Fluid Papers area.

New and enhanced! Selection visualization

An integral part of many artists’ workflows, selections can have hard, defined edges (like a rectangular box) or more free-form shapes with
transparency (like a Magic Wand or brushstroke selection). For Painter 2023, the color overlay has been added to widely-used selection tools
to give you improved visibility of selected areas. Especially useful for selections with complex shapes and transparency, the overlay helps to
speed up the creation, editing, and refinement of selections.

You can choose to visualize selections surrounded by the “classic” marquee, overlaid with color, or both. And you can quickly access these
settings from the new Selection View Options flyout on the property bar. Painter 2023 offers two color overlay presets, as well as custom
presets of any desired color. For example, if your artwork has shades of red, it is convenient to have an overlay color that makes it easy to see
your selections. In addition, a new Marquee Threshold control lets you adjust the level of pixel transparency contained in a selection so that
you can accurately include areas with lower opacity in a selection. For more information, see “Viewing Selections.”

View Feather

@)= m o

Marquee Threshold:

Overlay View Options

Preset: Default (Ruby)

Color:

Opacity:

Show: | Selected area

The new Selection View Options flyout makes it faster and easier to customize the visibility of selections.

Painter 2023 makes these controls readily available from property bars, menus, the Navigator, and the Canvas command bar to suit your
working preference and experience level. It's also easy to create a custom palette or assign a keyboard shortcut to frequently used tools and
commands.
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To set selection view options

* On the property bar, click the Selection View Options flyout button g4, and perform a task from the following table.

To

Set the pixel transparency level contained by the marquee

Set the overlay color

Set the overlay opacity

Choose an overlay preset

Create a custom overlay preset

Overlay a selected area

Overlay a protected area

View the overlay after you complete a selection

Enhanced! Selection Brushes

Do the following

Move the Marquee Threshold slider.

Higher values will include lower opacity pixels.
Click the color picker, and choose a color.
Move the Opacity slider.

Choose a preset from the Preset list box.

Click the Add Preset button +

Note: To delete an overlay preset, click the Delete Preset button —.

Choose Selected area from the Overlay list box.
Choose Masked area from the Overlay list box.

Disable the Hide Overlay check box.

Selection brushes bring the versatility of Painter’s brush engine to artists’ selection workflows. For Painter 2023, the updated property bars
for selections provide quicker access to the array of shapes and textures. You can instantly change a captured dab shape, or add a flow map
to enhance brushstroke texture. Plus, in response to feedback from Painter artists, new keyboard shortcuts let you instantly switch between
addition or subtraction selection modes so you spend less time finding controls and more time on the task at hand. For more information,

see "“Selecting areas by painting.”

New! Color Selection option

With Painter 2023, you can now use a selection brush to select within a range of color from any document. You can enable Color Selection
for any selection brush, or choose from four new preset color selection brush variants. You paint over the area of color that you want to
select based on a tolerance range, similar to using the Magic Wand tool. You can adjust the inclusion of colors and color brightness by
setting the tolerance for each characteristic. To suit particular styles, you can choose between smooth, anti-aliased edges for selecting color
from softer, traditional artwork and hard, aliased edges for precise comic-style artwork. Color selection is a great complement for working
with Painter’s masking and color adjustment features. For more information about color selection, see “Selecting color by painting.”
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Color Selection

¥ Enable Color Selection

The center of your brush sets the target
color with your first click.

Color Tolerance
Brightness Tolerance

¥ Smooth Jagged Edges

The new Color Selection panel lets you control the colors included in a brushstroke.

To make a color selection by painting
1 In the toolbox, click the Brush tool ‘/.
2 In the Brush Selector, click the Selection Brushes category and then click a variant.

3  On the property bar, click the Enable Color Selection button o

4 Click the Color Selection Options flyout button @ and perform an action from the following table.

To Do the following

Control the inclusion of colors adjacent to the target color Move the Color Tolerance slider.

Higher values include a broader range of colors.

Control the inclusion of color brightness adjacent to the target Move the Brightness Tolerance slider.

color
Higher values include a broader range of light and dark colors.

Smooth the edges of your selection by applying a 1-pixel feather Enable the Smooth Jagged Edges check box.

s
For better visualization of your color selection, click the Overlay button @ on the property bar.
If the color that you are selecting is similar to the overlay color, click the Selection View Options flyout button g4 on the property
bar and click the color picker to choose a different color.
You can add to your selection by holding down Shift, and painting over the area that you want to add.

You can subtract from your selection by holding down Option (macOS) or Alt (Windows), and painting over the area that you
want to subtract.

Enhanced! Selection workflow

Painter 2023 offers a smoother and more predictable selection experience through a variety of refinements. A new cursor for the Lasso
Selection and Polygonal Selection tools that makes it easier to connect the dots on your selection marquee. The property bars have been
revamped to both reset and remember settings, a helpful enhancement to speed up your selection work. In addition, a new Selection
Functions flyout elevates critical commands and modifications, such as enhanced 1-click feathering with a larger maximum size, so they are
always within reach.

And for selection-intensive tasks, you can also choose to open the Select panel in the workspace to reduce the number of clicks for selection
functions, such as saving, loading, inverting, modifying, and much more. Plus, you can now create a mask from a selection in a single step, a
frequent request among Painter users.
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Select

Feather:

M &

Select Panel:

The new Selection Functions flyout on the property bar puts the most frequently used selection commands and modifications at your
fingertips.

Simply moving selections around a document (x/y position) is also more reliable with Painter 2023. In addition, we've addressed an artist-
reported issue when using transparent gradients with selections, which offers greater creative possibilities. For more information about
selections, see “Getting started with selections.”

Enhanced! Glazing brushes

Glazing brush variants have been updated to use Enhanced Cover methods, which lets you use them with fluid paint. This gives Glazing
brushes access to the Fluid Paint flyout and property bar, which lets you enable and adjust relevant settings, such as Fill In Paper Grain, Fluid
Opacity, Accumulation, Paint Layering, and more.

Enhanced! Dropper and Paint Bucket tools

With Painter 2023, the Dropper and Paint Bucket tools remember your last-used settings between application launches, which makes it
easier to pick up right where you left off.

Enhanced! Layer visibility

In response to user feedback, Painter 2023 gives you the option of whether or not to include changes to layer visibility in your Undo Levels.
You can easily set and forget this option in the reorganized Preferences P General dialog box.
Enhanced! Place image

When you use the File » Place command with Painter 2023, a new option to Center on Layer makes it easy to place your image precisely
where you want it.

Enhanced! Gradients with transparency

When you work with gradients that have transparency, you will see a smoother, more natural transition along the gradient in Painter 2023.

Enhanced! Brush resizing

Painter 2023 provides a more responsive performance when you resize a brush incrementally by using the bracket keys or the touch wheel
on a Wacom or other popular tablet.
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Enhanced! Pick Up Underlying Color

The Pick Up Underlying Color button now works on Thick Paint layers, so you can use it with brushes from the Compatible Thick Paint
category for a smoother workflow. Note that brushes from the Bristles Thick Paint and Palette Knives Thick Paint categories do not pick up
color from underlying layers. For more information, see “Pick up colors from underlying layers.”

Workspace overview

The workspace is organized by using a series of menus, selectors, panels, and interactive palettes.
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Circled numbers correspond to the numbers in the following table,
which describes the main components of the application window.

Part Description

1. Menu bar Lets you access tools and features using pull-down menu options

2. Brush Selector bar Lets you access the Brush Selector flyout. It also allows you to
access the previously used brush variant and mark brushes as
favorite.

3. Brush Selector flyout Lets you choose a brush library, select a brush from a brush

category, apply brush filters to show only the brushes you need,
and browse additional brush packs that can complement your
creative set of brushes. It also lets you instantly identify which
brush variants are compatible with the Default, Liquid Ink, Thick
Paint, and Watercolor layers. When you hover over a brush variant,
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Part Description

eligible layer compatibility icons appear beside the brush name at
the bottom of the Brush Selector.

4. Command bars The command bars — File/Edit, Canvas, Photo Art — contain
buttons and controls that are shortcuts to many commonly used
menu commands

5. Property bar Displays commands that relate to the active tool or object. For
example, when the Fill tool is active, the fill property bar displays
commands for filling selected areas. Controls on the property bar
are organized logically for ease of use. Group labels help you find,
understand, and use commands quickly and efficiently.

6. Paint Opacity flyout Lets you access the controls for fluid paint. You can adjust grain
behavior, fluid opacity and accumulation levels, expression settings,
and paint layering.

7. Select panel Lets you access selection functions, such as contract, convert
to shape, expand, feather, load, modify border, remove, revert,
smooth, and save. You can also create selections from a layer or
group, based on image luminance, current or specified color, and
paper texture.

8. Color panel Lets you select a color and view information about the selected
color

9. Harmonies panel Lets you use harmony rules to create color harmonies

10. Layers panel Lets you manage the hierarchy of layers and includes controls for
creating, selecting, hiding, locking, deleting, naming, and grouping
layers

11. Papers panel Lets you apply and edit paper textures as well as open and manage

paper libraries, including the new Fluid Papers library

12. Color Selection panel Lets you adjust the behavior of selection brushes when selecting
color by painting

13. Canvas The canvas is the rectangular work area inside the document
window whose size determines the size of the image you create.
The canvas acts as the image background and, unlike a layer, it is
always locked.

14. Toolbox Lets you access tools for creating, filling, and modifying an image
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Choosing a workspace layout

A workspace layout (also known as “palette arrangement”) displays, hides, and positions workspace elements such as palettes and panels to
suit a specific workflow. Corel Painter 2023 offers the following workspace layouts:

Workspace layout Description

New to Painter Displays the most essential controls together with the Hints panel
to help you get started quickly with Corel Painter

Classic Ideal for users who have experience with previous versions of
Corel Painter and are looking for a seamless transition to a familiar
environment

Default The default workspace layout that works well for most computers.
For more information, see “Workspace overview” on page 10.

Simple Displays minimal user interface that includes the toolbox, the menu
bar, and the extended property bar

Concept Art Provides quick access to brushes, gradients, and texture painting
controls. Brush and media palettes are logically grouped in palette
drawers to save screen space.

lllustration Displays the Reference Image panel, brushes, papers, gradients

Fine Art Provides quick access to traditional media brushes and composition
tools

Photo Art Displays palettes commonly used by photo artists, providing

optimal setup for cloning photos, textures, and paintings

Manga Art Provides quick access to brushes, papers, and gradients, as well as
brush size and opacity controls

The Quick Switch feature lets you choose two workspace layouts and quickly switch between them to suit the current task or the display
mode of your device. This feature is especially useful on multi- or dual-mode devices. For example, you can select Default as Layout 1 and
Simple as Layout 2. When you flip the display panel from Notebook to Tablet mode, the Simple workspace layout is automatically displayed,
which lets you work in an uncluttered, minimalistic user interface.

To choose a workspace layout

* Choose Window P Layout, and choose a layout.
/.
C=

You can also choose a layout from the Welcome screen by clicking Setup and selecting a layout.
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To switch between workspace layouts
1 Choose Window P Layout » Quick Switch P Layout 1, and choose a layout.

2 Choose Window » Layout P Quick Switch P Layout 2, and choose a layout.
3 To switch between Layout 1 and Layout 2, do one of the following:
* Reposition the display panel of your dual- or multi-mode device (for example, from Notebook mode to Tablet mode).

* Choose Window P Layout P Quick Switch » Toggle Layout.

s
-
N

a0

You can switch between factory workspace layouts or custom workspace layouts that you created. For information about creating
and saving custom workspace layouts, see “Rearranging panels and palettes.”

Choosing and modifying brushes

Corel Painter 2023 brushes consist of a wide range of preset painting and drawing tools called brush variants. Brush variants are organized
into a wide variety of categories, such as Airbrushes, Artists’ Oils, Calligraphy, Pens, Pencils, and Real Watercolor. Some brush categories
are designed with real media in mind, so you can select a tool with an expectation of how it will behave. Other brush categories have no
real-media equivalent, such as the ground-breaking Particle brushes, and give digital artists the ability to express themselves in ways never
thought possible.

The Brush Selector lets you choose a brush library, select a brush from a brush category, and browse additional brush packs that can
complement your creative set of brushes. It also allows you to organize and display brushes in various ways. For example, you can filter
brushes to show only the brushes you need. You can also show or hide Brush Selector parts to suit your workflow. For example, you can
show or hide the Brush Library Selector, recently used brushes, brush pack promotions, and more.

The Brush Selector also lets you instantly identify which brush variants are compatible with the Default, Liquid Ink, Thick Paint, and
Watercolor layers. When you hover over a brush variant, eligible layer compatibility icons appear beside the brush name at the bottom of the
Brush Selector. Clicking a layer compatibility icon lets you find all brush variants that paint on this layer.

[~ 4P Pencils
@ 4 Soft 2B

New brushes added... e
Bno Painter 2023 Brushes b

& reryiics b
¥ hirbrushes

/ Blenders : General Soft 68
 Blenders : Messy
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& Cloners : Touch-up .

£ conte Sicesy

& erasers

#/ Fluid : Build and Sculpt )

I/ Fluid : Paint and Blend e
¥« F-x § vt
# clazing

/ Gouache
& Graphic ..

Hard Grainy

B image Hose Thick and Thin
# impasto
& ink : Buildup

*® Ink : Liquid Mechanical
Layer compatibility:
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Circled numbers correspond to the numbers in the following table, which describes the main components of the Brush Selector.

———
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Part Description

1. Last Used Brush Lets you access the previously used brush variant

2. Brush Selector Bar Lets you access the Brush Selector flyout

3. Mark as Favorite Lets you mark the selected brush as favorite

4. Brush Library Selector Lets you choose a brush library

5. Brush Pack Promotions bar Lets you access the Brush Pack Selector and purchase brush packs
6. Brush library options button Lets you access commands that help you organize and display

brushes in various ways

7. Brush Pack Selector Lets you browse the available brush packs
8. Filter Brushes button Lets you apply brush filters to show only the brushes you need
9. Brush categories Lets you browse all categories in a brush library. Brush categories

are groups of similar brushes and media.

10. Brush variants Lets you browse the brush variants in a category. Brush variants are
specific brushes and brush settings within a brush category.

11. Layer compatibility icons Lets you identify and search for brush variants that are compatible
with the Default, Liquid Ink, Thick Paint, or Watercolor layers

In the Painter 2023 Brushes library, brushes are organized into categories, which are groups of similar brushes and media. Brush variants are
specific brushes within a brush category. The Brush Selector is also available as a floating panel that you can keep open to access brushes
quickly and easily while you are painting. The Brush Selector panel has two viewing modes: compact and full view. In full view, both the
brush categories and variants are displayed. In compact view, only the brush variants are displayed, which lets you see more brushes at a
glance without the need to scroll.
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(left) Brush Selector panel in compact view, (right) Brush Selector panel in full view

To show or hide the Brush Selector

* Perform a task from the following table.

To show or hide Do the following

The Brush Selector bar Choose Window P Brush Selector P Bar.

The Brush Selector panel in full view Choose Window P Brush Selector P Panel (Full View).
The Brush Selector panel in compact view Choose Window P Brush Selector P Panel (Compact).

To select a brush category and variant
1 In the toolbox, click the Brush tool ,/.

2 Click the Brush Selector on the Brush Selector bar.

3 Click a brush category, and click a brush variant.

Filtering brushes

Brush filters let you show only the brushes you need for the creative task at hand. For example, you can apply the Thick Paint Compatible
filter to show only Thick Paint and Thick Paint compatible brushes and hide all other brushes from the Brush Selector.

Corel Painter provides several brush filters: My Favorites, Painter Masters, Stamps, Watercolor Compatible, Thick Paint Compatible, and
Cloners. To fine-tune your selection of brushes, you can apply two or more filters at the same time. For example, you can show only your
favorite Watercolor Compatible brushes.
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Apply one or more brush filters to hide the brush categories and brushes that you don’t need.

You can clear one or more filters to expand your brush selection, and you can clear all brush filters to display all brushes in the active brush
library.

To filter brushes

1 In the toolbox, click the Brush tool ’/.

2 Click the Brush Selector on the Brush Selector bar.

3 In the Brush Selector flyout, click the Filter Brushes button Y » to show the list of available brush filters.
4 Enable one or more of the following check boxes:

* My Favorites — shows only the brushes you have marked as favorites. For more information about favorite brushes, see “Marking
brushes as favorite” on page 17.

* Painter Masters — shows only brushes that are highly valued and used by Painter masters

* Stamps — shows only stamp-type brushes that use the Circular, Captured, Computed Circular, or Static Bristle dab types
* Watercolor Compatible — shows only Watercolor brushes and brushes that can be used on Watercolor layers

* Thick Paint Compatible — shows only Thick Paint brushes and brushes that can be used on Thick Paint layers

* Cloners — shows only cloner and clone tinting brushes

When a brush filter is applied, the outline of the Filter Brushes button changes from white to orange .

=¢

Brush filters are applied only to visible brushes. Hidden brush categories and brush variants remain hidden.

To clear filters

* In the Brush Selector flyout, click the Filter Brushes button Y», and do one of the following:
* To clear all filters, click Clear Filters. All brush variants and brush categories included in the active brush library are displayed.

* To clear a specific filter, disable the filter check box.
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Marking brushes as favorite

Marking the brushes you like as favorite helps you easily find them by the Favorite icons that appear beside their names. You can mark
the selected brush as favorite from the Brush Selector bar with one click. To mark multiple brushes as favorite, it is faster to use the Brush
Selector flyout or the Brush Selector panel. You can remove a brush from your list of favorites at any time.

I.- Paint and Blend 4

The selected brush (left) is marked as favorite (right) from the Brush Selector bar.
You can show only your favorite brushes in the Brush Selector by applying the My Favorites filter.

To mark the selected brush as favorite
* On the Brush Selector bar, click the Mark as Favorite icon ' located to the right of the brush name.

)

s
N
N

You can also mark a brush as favorite in the Brush Selector flyout or Brush Selector panel by right-clicking the brush and clicking
Favorite. Use this method when you want to mark multiple brushes as favorite.

To remove the selected brush from your list of favorites

¢ On the Brush Selector bar, click the Remove from Favorites icon E| located to the right of the brush name.
s
C=

You can also remove a brush from your favorites in the Brush Selector flyout or Brush Selector panel by right-clicking the brush and
clicking Favorite. Use this method when you want to remove multiple brushes from your favorites.

Finding brushes

You can quickly search the content of the currently selected brush library to find brushes that match a specific description. You can perform a
search by entering one attribute, or a combination of brush attributes. For example, typing the search terms “pencil real” generates a list of
all “Real Pencil” brush variants. Plus, you can use abbreviated search terms "d", "tp", "li", and "wc" in the Search bar to find respective Default,
Thick Paint, Liquid Ink, and Watercolor brushes. In addition, the search term "gl" will instantly find all brushes that require Gel composite
method for optimal look and feel.

To search for brush variants
1 In the Search bar (Window P Search), type one attribute or a combination of brush attributes in the Search text box.
2 Hover over a brush variant in the list to display a preview of the brushstroke at the bottom of the flyout.

3 Choose a brush variant from the list.

=

The Search bar is displayed by default only in the Classic layout and is located to the right of the property bar, in the upper-right
corner of the document window. To display the Search bar in all other layouts, click Window P Search.

)
7\S

You can use GPU and Multi-core (or “Multicore”) as search terms to find brushes that leverage those technologies. If you have
a Mac or Windows computer that uses Intel processors, you can search using the term AVX2 to find brushes that leverage those
extensions. If you have a Mac computer that uses an Apple CPU, you can search using the term NEON.

If you previously hid the Search bar, you can show it by clicking Window » Search.
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Modifying brushes

When the Brush tool is selected, you can quickly modify a brush variant on the property bar. Some basic attributes, such as size and opacity,
are common to all brushes, and other attributes are specific to the brush category that you've chosen.

Controls on the property bar are organized logically for ease of use. Group labels help you find,
understand, and use commands quickly and efficiently. (1) The Reset button lets you restore the default
settings of a selected brush, (2,3,4) Controls common to all brushes, (5, 6, 7) Brush-specific controls,;
(8) The Advanced Brush Controls button lets you access the panels related to the active brush variant.

Depending on the brush category and variant you select, the property bar contains flyouts that provide access to the most commonly used
functions that are relevant to the active brush or tool.

The property bar for a Real Watercolor brush variant: (1) the Stroke flyout, (2) the Flow map flyout, (3) the Real Watercolor
flyout button, (4) the Dab Options flyout, (5) the Static Bristle flyout button, The background shape of icons indicates
their use. A square background (4) signifies that the control gives access to settings that let you modify the media
properties of a brush. Icons with a round background (4, 5) give access to settings that control the shaping of a brush.

To set basic brush attributes
1 In the toolbox, click the Brush tool ’/.
2 Click the Brush Selector on the Brush Selector bar.
3 Click a brush category, and click a brush variant.
4 On the property bar, do any of the following:
* To set brush size, move the Size slider @), or type a value in the Size box.

* To set brushstroke opacity, move the Opacity slider @, or type a percentage in the Opacity box.
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You can also set brush size by choosing a size preset from the Size library. Click the Size flyout button @ on the property bar,
click the Size Library button e, and click a preset in the Brush Sizes panel.

You can also increase brush size incrementally by pressing the right square bracket (] ) key or decrease brush size by pressing the
left square bracket ([ ) key.

When the Brush tool is active, you can set opacity by pressing a number key. Each number key is mapped to a fixed percentage. For
example, 1 equals 10% opacity, 5 equals 50% opacity, and 0 equals 100% opacity.

Exploring brush categories

Corel Painter 2023 has a wide selection of brush categories, each with a variety of preset brush variants.

Creating custom brushes

You can choose a ready-to-use default brush variant from the impressive Corel Painter brush library, or you can modify a brush variant in the
General brush control panel. It contains the following settings:

* Dab Type — determines the method for applying media to the canvas
* Stroke Type — determines how a brushstroke applies media

* Method and Subcategory — method defines the most basic level of brush behavior and is the foundation on which all other brush
variables are built. The method and method subcategory represent attributes of the stroke’s appearance.

* Source — determines the media that is applied by the brush variant

For more information about using the General brush control panel, see “General Controls” in the product Help.

To display the General Brush Controls panel

* Choose Window P Brush Control Panels » General.

Exploring the toolbox

You can use the tools in the toolbox to paint, draw lines and shapes, fill shapes with color, view and navigate documents, and make
selections.

The following table provides descriptions of the tools in the Corel Painter toolbox.

Tool

Description

Color tools

V4

»

&

The Brush tool lets you paint and draw on the canvas or a layer.
The property bar displays the most commonly used functions
that are relevant to the active brush. For more information, see
“Selecting, managing, and creating brushes.”

The Dropper tool lets you pick up a color from an existing image.
The property bar shows the values of the color. When you select a
color with the Dropper tool, that color becomes the current color
in the Color panel. For more information, see “Sampling colors
from images.”
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Tool

&

L

4

Selection tools

N
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Description

The Paint Bucket tool lets you fill an area with media, such as a
color, gradient, pattern, weave, or clone. The property bar shows
options for the areas that you can fill and the media that you can
use. For more information, see “Working with color fills.”

The Interactive Gradient tool lets you apply a gradient to an image
by filling an area, such as the canvas, a selection, layer, or channel.
For more information, see “Applying gradients.”

The Eraser tool lets you remove unwanted areas from an image.
For more information, see “Erasing image areas.”

The Layer Adjuster tool is used to select, move, and manipulate
layers. For more information, see “Displaying the Layers panel.”

The Transform tool lets you modify selected areas of an image by
using different transformation modes. For more information, see
"Preparing selections for transformations.”

The Rectangular Selection tool lets you create rectangular
selections. For more information, see “Getting started with
selections.”

The Oval Selection tool lets you create oval selections. For more
information, see “Getting started with selections.”

The Lasso tool lets you draw a freehand selection. For more
information, see “Getting started with selections.”

The Polygonal Selection tool lets you select an area by clicking
different points on the image to anchor straight line segments. For
more information, see “Creating path-based selections.”

The Magic Wand tool lets you select an area of similar color
by clicking or dragging in an image. For more information, see
“Creating pixel-based selections.”

The Selection Brush tool lets you create a freehand selection by
painting. For more information, see “Selecting areas by painting.”

The Selection Adjuster tool lets you select, move, and manipulate
selections created with the Rectangular, Oval, and Lasso selection
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Tool Description

tools and selections converted from shapes. For more information,
see "Preparing selections for transformations.”

ﬁ The Crop tool lets you remove unwanted edges from an image. For
more information, see “Cropping images.”

Shape tools

@s The Pen tool lets you create straight lines and curves in objects. For
more information, see “Drawing lines and curves.”

The Quick Curve tool lets you create shape paths by drawing
freehand curves. For more information, see “Adjusting curvature.”

The Rectangular Shape tool lets you create rectangles and squares.
For more information, see “Drawing shapes.”

The Oval Shape tool lets you create circles and ovals. For more
information, see “Drawing shapes.”

- @ m

The Text tool creates text shapes. Use the Text panel to set the font,
point size, and tracking. For more information, see “Adding text.”

k The Shape Selection tool is for editing Bézier curves. You use
the Shape Selection tool to select and move anchor points and
adjust their control handles. For more information, see “Selecting a
shape.”

oX) The Scissors tool lets you cut an open or closed segment. If the
segment is closed, after you click on a line or point, the shape path
becomes open. For more information, see “Cutting and joining
shape segments.”

The Add Point tool lets you create a new anchor point on a shape
path. For more information, see “Adding, deleting, and moving
anchor points.”

AOX

—@s The Remove Point tool lets you remove an anchor point from a
shape path. For more information, see “Adding, deleting, and
moving anchor points.”

/[L The Convert Point tool is used to convert between smooth and
corner anchor points. For more information, see “Adjusting
curvature.”
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Tool

Photo tools

Symmetry tools

e

A2
e
e

Composition tools

\D

£
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Description

The Cloner tool gives you quick access to the last Cloner brush
variant you used. For more information, see “Painting in the clone.”

The Rubber Stamp tool gives you quick access to the Straight
Cloner brush variant and lets you sample areas within an image
or between images. For more information, see “Performing offset
sampling.”

The Dodge tool lets you lighten the highlights, midtones, and
shadows in an image. For more information, see “Dodging and
burning.”

The Burn tool lets you darken the highlights, midtones, and
shadows in an image. For more information, see “Dodging and
burning.”

The Mirror Painting mode lets you create a perfectly symmetrical
painting. For more information, see “Using the Mirror Painting
mode.”

The Kaleidoscope mode lets you transform basic brushstrokes
into colorful and symmetrical kaleidoscope images. For more
information, see “Using the Kaleidoscope Painting mode.”

The Divine Proportion tool lets you plan compositions by using
guides based on a classical composition method. For more
information, see “Using the Divine Proportion tool.”

The Layout Grid tool lets you divide your canvas so that you can
plan your composition. For example, you can divide your canvas
into thirds vertically and horizontally to use the compositional rule
of thirds. For more information, see “Using the Layout Grid.”

The Perspective Guides tool lets you display guides using one-,
two-, or three-point perspective. For more information, see “Using
Perspective Guides.”
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Navigation tools

Tool Description
@ The Grabber tool lets you scroll through an image quickly. For more
information, see “Repositioning images.”

p The Magnifier tool lets you magnify areas of an image when you
are performing detailed work, or reduce areas to get an overall
view of an image. For more information, see “Zooming images.”

O The Rotate Page tool lets you rotate an image window to
accommodate the way you naturally draw. For more information,
see "Rotating images and the canvas.”

Selectors

The View selector allows you to switch between document
views and viewing modes. For more information, see “Switching

document views.”

The toolbox is open by default, but you can close it by clicking the close button on the toolbox header bar. To reopen the toolbox,
choose Window P Toolbox.

Exploring panels and palettes

The interactive panels in Corel Painter are single tabbed containers that let you access content libraries, commands, controls, and settings.
Panels are stored in palettes. You can turn a palette into a palette drawer, so you can quickly collapse it to save screen space.
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This palette drawer includes two related panels: Gradients and
Gradient Node. You can access a panel’s content by clicking its tab.

Exploring panels

Most panels in Corel Painter contain option menus from which you can access a series of related commands. For example, you can use the
options menu in the Layers controls panel to lock, duplicate, and group layers.

or Set Libraries

A typical palette features a header bar (1), a Palette Drawer button that lets you turn a palette into a palette
drawer (2), panel tabs (3), and a Panel options button that allows you to access a series of related commands (4).

The following table contains descriptions of the most frequently used panels. For more information about other panels, see “Exploring
panels” in the product Help.

Panel Description

Brush Control panels

The brush control panels are included in the Brush Controls palette.  Allow you to customize brush variants. For more information, see
The brush controls are divided into multiple brush control panels "Adjusting brushes with brush controls.”

that allow you to adjust a brush variant while you work, or alter an

existing variant to create a new variant.
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Panel Description

Advanced Brush Controls panel Generates a grouping of brush control panels that are relevant to
the currently selected brush. You can access brush shape and brush
media panels quickly by using the Shape and Media shortcuts
in the Edit panel. For more information, see “Exploring Brush

Controls.”

Color panels

Color Panel (Full View) Let you choose main and additional colors and create color
harmonies. For more information, see “Choosing colors from the

Color Panel (Compact) .

Color panel.

Mixer Lets you mix and blend colors as you would on an artist's palette.
For more information, see “Exploring the Mixer panel and mixing
controls.”

Color Set Libraries Displays the colors in the current color set so you can organize
groups of colors. For more information, see “Working with color
sets.”

Harmonies Lets you use harmony rules to create color harmonies. For more

information, see “Working with color harmonies.”

Layers and Channels panels

Layers Lets you preview and arrange all layers. You can use Dynamic Plug-
ins, add new layers (including Default, Thick Paint, Watercolor, and
Liquid Ink layers), create layer masks, and delete layers. In addition,
you can set the composite method and depth, adjust the opacity,
and lock and unlock layers. For more information, see “Layers.”

Channels Lets you preview thumbnails of all the channels in a Corel Painter
document, including RGB composite channels, layer masks, and
alpha channels. From the panel, you can also load, save, and invert
existing channels, and create new channels. For more information,
see "Alpha Channels.”

Working with panels and palettes

When you launch Corel Painter 2023, the Color panel is open automatically and is grouped in a palette drawer with the Mixer, Harmonies,
Color Set Libraries, Layers, and Channels panels. The Color panel has two viewing modes: compact and full view. In full view, both the
color wheel and sliders are displayed. In compact view, only the sliders are displayed. By default, the Color panel in full view displays the
color wheel, and information for a selected color, but you can hide these elements.
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Saturationy Value To mgl =
Hue Ring

Addirional Colar

Clone Calar
Main Color
The Color panel in full view
To hide information on the Color panel
1 Choose Window P Color Panels P Color Panel (Full View).
2 Perform a task from the following table.
To Do the following
Hide the color wheel Click the Color options button =, and choose Color Wheel.
Hide color information Click the Color options button =, and choose Color Sliders.

You can easily display a panel when you need it, and you can quickly close a panel when you're done.

To hide or show a panel or palette

* Choose Window P [Panel name].

2
N
N

)

You can restore a previously hidden palette by choosing Window and choosing the name of a panel that is contained in the
palette.

You can save the arrangement of palettes as a custom workspace layout for later use, and you can delete this custom workspace layout
when you no longer need it.

You can rearrange the display of panels to better match your workflow. For example, you can group task-related panels together in one
palette. At any time, you can further customize these palettes by adding or removing a panel, repositioning a panel, or moving a panel to
another palette.
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To group panels into palettes
* Perform a task from the following table.

To

Group panels into a palette

Add a panel to a palette

Remove a panel from a palette

Reposition a panel in a palette

Do the following

Drag a panel by its tab to another open panel to create a group.

Drag the panel tab to the palette.

Drag the panel tab out of the palette.

Drag the panel tab to a new location in the palette.

Palettes and panels float in the workspace. Docking attaches panels or palettes to the vertical edge of the application window. Undocking

detaches them from the workspace, so you can move them.

To dock or undock a palette or a panel
* Perform a task from the following table.

To

Dock a palette

Undock a palette

Dock a panel

Undock a panel

Do the following

Drag the palette header bar to the vertical edge of the application
window. The palette snaps into place when it lines up with the
edge.

Drag the blank area to the right of the panel tabs away from the
edge of the application window.

Drag the panel tab to the vertical edge of the application window.
The panel snaps into place when it lines up with the edge.

Drag the panel tab away from the application window.

You can turn a palette into a palette drawer, so you can quickly collapse it to save screen space. At any time, you can turn a palette drawer
back into a regular palette. You can resize and reposition a palette drawer like any other palette group.

To use a palette drawer

* Perform a task from the following table.

To

Create a palette drawer

Do the following

Click the Palette Drawer toggle button === on the palette header
bar, and click Palette Drawer.

To turn a drawer into a regular palette, repeat the preceding steps.
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To Do the following

Expand or collapse a palette drawer Double-click the header bar of the palette drawer.
Hide a palette drawer Click the Close button D on the header bar.
Show a palette drawer Choose Window P Palette Drawers P [Palette drawer name].

Creating custom palettes

Corel Painter lets you create custom palettes that contain only the features that you want so you can quickly access them. For example, you
can place items from the Brush library panel or any of the Media library panels in a custom palette. You can also add commands from the
main menus or panel options to custom palettes. For more information, see “Creating and modifying custom palettes” in the product Help.

You can change how items on a custom palette are displayed. For example, you can display them as text, icons, or wide icons.

To quickly create a custom palette
* Press Shift, and do any of the following:
* Drag a brush variant from the Brush Selector panel to the document window.

* Drag a paper, flow map, or media library thumbnail from the Paper libraries (Window P Media Panels P Papers), Flow Map libraries

(Window P Media Panels P Flow Maps), or the other Media panels (Window P Media Panels P [Textures, Patterns, Gradients,
Nozzles, Looks, Weaves Library Panel]) to the document window.

To add menu commands, controls, or tools to a custom palette
1 Choose Window P Custom Palette » Add Command.
2 From the Select Custom Palette list box, choose New to create a new palette or select an existing custom palette.

3 With the Create Palette/Add Command dialog box open, perform a task from the following table:

To add Do the following

A menu item Choose a menu item from a default Corel Painter menu.
Additional controls Choose a menu item from the Other menu.

A panel, or any item included in a panel’s options flyout menu Choose a menu item from the Panel Menus menu.

A toolbox tool Choose a menu item from the Tools menu.

An item from an open palette Click the item.

4 In the Create Palette/Add Command dialog box, click Add, and then click OK.

Choosing a workflow

Corel Painter includes a wide array of tools and features that allow you to create original artwork and use the workflow that best suits your
creative style.
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Using Corel Painter’s powerful cloning tools, you can quickly transform a digital photo into a painting. You can also use a photo as a starting
point for a painting with the tracing paper feature, which displays a faded-out version of the source image beneath the clone document and
allows you to precisely apply clone colors to the canvas.

If you prefer to start with a sketch created with traditional art tools, you can scan it and finish the painting digitally in Corel Painter. You can
also start a project from scratch in Corel Painter by choosing a paper texture and a brush, and applying color to the canvas.

Photo art: Photo painting

A great way to become acquainted with Corel Painter is to create photo art by painting on a photo. All you need is a photo to use as a
source image. The Photo Art workspace layout displays only the palettes and tools that are relevant to photo painting.

You can use various preset styles to turn your photo into a painting.

Corel Painter includes powerful image cloning tools to help you transform an existing image, such as a photograph, into a work of art. You
can use the Quick Clone feature to automatically set up everything you need to clone an image, or you can start from a blank document
and add one or more clone sources. A clone source is a reference — a guide — for brush colors. You clone (copy) color from a clone source
and apply it to a destination canvas (clone document). A clone source may or may not be embedded. Embedding a clone source allows you
to keep it with your document and switch quickly between clone sources as you paint. You can use images, textures, and patterns as clone
sources. If you plan to use a clone source only once — for example, if you want to turn a photo into a painting — you can embed it as an
image. If you plan to reuse a content asset as a clone source in multiple projects, you can store it as a texture or a pattern in the Texture or
Pattern library, respectively. Corel Painter supports PNG and RIFF clone sources with transparency and lets you easily transform textures in the
context of your composition to make them suit your artistic vision. For more information about cloning, see “Image cloning and sampling”
in the product help.

In this guide, we describe one of many possible photo-painting workflows for creating a composite image. We use a painting by Karen
Bonaker as a guide to show how you can use an embedded image and a texture as clone sources. Feel free to experiment with the tools and
settings shown to create your own digital art from scratch.

Corel Painter also has auto-painting tools that streamline the process of creating a painting that is based on a digital image or scanned
photo. Previous experience with digital art is not required to use these tools. For more information, see “Auto-painting photos” in the
product help.

To display the Photo Art workspace layout
* Choose Window P Layout P Photo Art.
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To clone an image using Quick Clone

1 Open the image that you want to clone.

2 Choose File » Quick Clone.

3 Apply brushstrokes to the canvas by using a cloner brush.

As you paint, you can turn the tracing paper off and on by choosing Canvas P Tracing Paper.
/.
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You can also choose a brush from any other brush category and set it to clone color by clicking the Clone Color button #p on the
Color panel.

To add clone sources to a document
1 Open or create a document.

Corel Painter supports PNG and RIFF clone sources with transparency. In this example, Karen Bonaker used a transparent PNG.

2 |n the Clone Source panel (Window P Clone Source), choose Embedded Image from the Source list box. In the Embed Source Image
dialog box, enable the Current Document option, and choose the document that you want to clone from the list of open documents.

Tip: To embed an additional image, click the Embed Source Image button p=, and click Browse. Locate the folder that contains the
image that you want to use, and click Open.

3 To add a texture as a clone source, in the Clone Source panel, choose Texture from the Source list box. Click a texture thumbnail in the
list. Enable the Show Texture check box to see the texture in the document window.
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Create your content assets, import them into the Texture library, and use them as clone sources in your painting or photo collage.

Tip: Before you clone a texture, you can modify its appearance to suit your composition and concept. Learn more about modifying
textures in the Help.

4 In the Brush Selector panel (Window P Brush Selector P Panel (Full View)), choose a brush from the Cloners categories.
5 Paint in the clone document to clone the texture.

In this example, Karen Bonaker used a custom texture.

Tip: To embed a texture into a clone document so that it's saved with the document for future use, in the Clone Source panel, right-click
a texture thumbnail (Windows) or hold down Control and click a texture thumbnail (macOS), and click Embed Texture as Clone Source
Image.

To switch to the embedded source image, in the Clone Source panel, choose Embedded Image from the Source list box.

7 Paintin the clone document to clone the image. As you paint, you can turn the tracing paper on and off by enabling or disabling the
Toggle Tracing Paper check box in the Clone Source panel.

Corel Painter 2023 | 31


http://apps.corel.com/redirect?_redirect=command&function=help&version=2023&app=Painter&lang=en&topic=TRANSFORMING_EDITING_TEXTURES
http://apps.corel.com/redirect?_redirect=command&function=help&version=2023&app=Painter&lang=en&topic=TRANSFORMING_EDITING_TEXTURES

In this painting, Karen Bonaker used an embedded image and a texture as clone sources.

7\

Experiment with other variants from the Cloners brush categories.

Examples of brush variants from the Cloners brush categories.
You can transform any brush into a cloner brush by clicking the Clone Color button #p in the Color panel.

Photo art: Tracing

In addition to painting on a photo, you can use tracing paper to outline a photo or other artwork. You can then use the outline as a starting
point for a painting. Or you can trace a photo to create a sketch, such as a charcoal or chalk drawing.
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Tracing a photo to create a sketch

To trace a photo

1
2

3
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Open the photo or other artwork that you want to trace.
Choose File » Quick Clone.

In the Clone Source panel (Window P Clone Source), make sure the Toggle Tracing Paper check box is enabled, and in the Clone Color
panel (Window P Brush Controls Panels » Brush Media P Clone Color), disable the Enable Clone Color check box.
Now you can see a visual reference of the original photo as you paint, but you can choose the color that you paint with.

Draw on the canvas to outline the image by using the underlying image as reference.

By varying the pressure of the stylus, you can apply darker or lighter tones. The shading doesn’t have to be exact.

2
N

You can change the opacity of tracing paper by moving the Opacity slider in the Clone Source panel, or turn off the tracing paper
by disabling the Toggle Tracing Paper check box.

Starting from a scanned illustration

With Corel Painter, you can easily cross over to the digital world from pencil and paper. Many graphics professionals still prefer to start with a
hand-drawn illustration, scan it, and then import the scan into Corel Painter.

First, you scan a sketch done in any medium on white paper to the JPEG or TIFF file format.

To place a scanned illustration

1

2
3

Choose File P New to create the document into which you'll place the scanned image.

In the New Image dialog box, specify the document width and height by using roughly the same dimensions as your scan.
Choose File P Place, browse to the scan, select it, and click Open.

You can use the outline of the scan that appears to position the sketch.

Click the document when the outline is in position, or click OK in the Place dialog box.
The scanned sketch becomes a new layer.
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Artwork by Dwayne Vance

When you scan or photograph a sketch, there might be smudging picked up by color scanners or lighting imperfections in a photo. You
can quickly correct these issues by hiding the canvas and changing its composite method, which lets you determine how a layer blends with
an underlying image. For example, change the layer's composite method to Gel to see the sketch on a transparent background. With this

method, anything that is white is made transparent.

To make the sketch background transparent
1 In the Layers panel, click the eye icon &g next to the canvas.

2 Select the sketch layer, and choose Gel from the Composite Method list box.

/.
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You can also work in Gel mode when the canvas is visible by first filling the canvas with a color other than white. This allows you to

paint on the canvas, so you can paint underneath the sketch. This method is used by many graphics professionals because it allows
them to paint large parts of the sketch quickly and then clean it up with the Eraser tool 4.
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Artwork by Dwayne Vance
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You can also open a scanned file directly in Corel Painter, rather than place the scanned sketch in a new document. There is no guesswork in
trying to size your document. Keep in mind that when you open a scanned file, it's mounted to the canvas, so lifting it off the canvas onto
its own layer offers you greater flexibility.

To open a scanned illustration

* Choose File » Open, browse to the scanned file, select it, and click Open.

To lift the canvas to a layer

1 Inthe Layers panel, right-click the canvas, and choose Lift Canvas to Watercolor Layer.
The default composite method for Watercolor layers is Gel.

2 Double-click the Watercolor layer, and type Sketch in the text box.
3 If you want to use a variant from a brush category other than Watercolor, right-click the layer, and choose Convert to Default Layer.
You can use shapes and selections to add line work over the sketch for reference. Alternatively, you can copy the line work to its own layer

and incorporate it into the painting. Another technique that design professionals use when they start with a scanned sketch is to create
shapes that mirror parts of the sketch. You can then snap a brushstroke to the shape or fill it with color.

To use shapes to recreate the sketch
1 Click any of the following tools in the toolbox to create shapes that replicate portions of the sketch:
* Pen tool gy to create straight lines and curves in objects

* Quick Curve tool 7, to create shape paths by drawing freehand curves, which are ideal for tracing areas of the sketch
* Rectangular Shape tool [ to create rectangles and squares
* Oval Shape tool @ to create circles and ovals
2 Click any of the following tools in the toolbox to fine-tune a shape so that it better mirrors an area of the sketch:
* Shape Selection tool £ to select and move anchor points and adjust their control handles
* Add Point tool 7y to create a new anchor point on a shape path
* Remove Point tool 7y to remove an anchor point from a shape path

You can't paint on a Shape layer, so when you're satisfied with the look of a shape, select its layer, and click the New Layer button g in
the Layers panel to create a layer above the shape layer.

3 In the toolbox, click the Brush tool ’/.
4 Click the Brush Selector on the Brush Selector bar, and choose a brush category and variant.
5 On the property bar, click the Stroke Options flyout button #_, and click Align to Path &

Brushstrokes within the tolerance area of a path or shape are automatically aligned.

In the Layers panel, select the layer you added above the shape layer, and paint.
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If you use closed shapes, you can convert them to selections that can be filled with the Paint Bucket tool ¢ . First, select the
shape, and then choose Shapes P Convert to Selection.
Drawing and painting from scratch

When you draw or paint from scratch, you start by setting up the canvas size, resolution, and orientation. When setting the canvas size and
resolution, keep in mind that a larger image size preserves more image detail and makes it easier to maintain image quality when you need
to produce a smaller version of the image. For more information, see “Understanding resolution” and “Resizing images and the canvas.”

In this guide, we use a painting created by renowned Corel Painter Master Mike Thompson as a guide. Feel free to experiment with the tools
and settings shown to create your own digital art from scratch.
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To set up your painting

1 Choose File » New, and choose any options to set up your canvas.
2 Type a value in the Resolution box.
In the sample image, the resolution is set to 200 dpi.
3 Choose a unit of measurement from the Units list box, and set the image width and height.
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In the sample image, the unit of measurement used is inches. The width is set to 10 inches, and the height is set to 12 inches.

4 Click the Canvas Color selector, and choose a color from the color picker.
In the sample image, white is used.

(6]

Click the Paper selector, and choose a paper texture from the Papers panel.
In the sample image, Basic Paper is used.
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To get started quickly, you can create a Thick Paint, Watercolor, or Liquid Ink layer, set canvas visibility and orientation, and choose a
color profile directly from the New Image dialog box.

The maximum canvas size is 16 382 x 16 382 pixels. To prevent performance issues, start with a canvas that is smaller than 16 382
x 16 382 because layers expand when paint and effects are applied close to their edges.

If you're basing your painting on a photo, design, or another piece of digital art, the Reference Image panel makes it easy to keep a visual
source of inspiration within sight while you create. It's the perfect way to capture subtle elements that will enhance your artwork without
disrupting your workflow. You can resize the panel by dragging from the lower-right corner. In the Reference Image panel, you can even
sample colors from the image, reposition the image, as well as zoom in or out.
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To display a reference image
1 Choose Window P Reference Image.
2 In the Reference Image panel, click the Open Reference Image button p=.
3 In the Open Reference Image dialog box, locate the file that you want to open.
You can open reference images that are saved to the following file formats: JPG, PNG, RIFF, and PSD.
4 (lick Open.
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When you open RIFF, TIFF, and PSD files that contain layers in the Reference Image panel, all layers are flattened.

To sample a color in a reference image, click the Dropper tool / move the cursor to the color that you want to sample, and click
it. The color swatch is updated to display the color you've selected.

With the document set up, now it's time to choose a brush, select a color, and start painting. Corel Painter offers a wide range of brushes
that are designed with the real media in mind, so you can predict how a brush will behave. Corel Painter brushes can paint or draw with any
kind of media — not just oils and watercolor, but also pencils, pens, pastels, and other media.

Individual brushes, known as brush variants, are stored in the Brush Selector in different brush categories. For more information, see
“Choosing and modifying brushes” on page 13.

You can use the brush variants as they are, or you can adjust them to suit your purposes. Many artists use brush variants with only minor
adjustments to size, opacity, or grain (how brushstrokes interact with paper texture). These settings are found on the property bar.

To choose a brush and change its color
1 In the toolbox, click the Brush tool ’/.

2 From the Brush Selector bar, choose a brush category, and then choose a brush variant.
In the sample image, Mike used the Soft 2B Pencil variant from the Pencils brush category.

3 To change the color, on the Color panel, drag the Hue Ring to display the range of colors you want, and click the Saturation/Value
Triangle to specify the color.

The top of the triangle represents the highest value (white), and the bottom of the triangle represents the lowest value (black).
Saturation levels increase from left to right. Dragging to the right, or clicking on the right, produces purer colors within the predominant
hue. Dragging to the left, or clicking on the left, reduces the color saturation and produces “muddier” or grayer colors.

In the sample image, Mike started with a light blue.

Corel Painter 2023 | 37



When you start a painting from scratch, it's a good idea to place each element of your painting on its own layer. This allows you to modify
and manipulate the content of a layer independently of other layers and the canvas. It also allows you to use one layer as a sketch, which
you can then trace on another layer with more detail and precision.

To add and manage layers

1 In the Layers panel (Window P Layers), click the New Layer button  to create the sketch layer.
2 Double-click the new layer in the Layers panel, and name it Sketch.

3 In the toolbox, click the Brush tool ’/, and create a rough sketch that will serve as the foundation of the painting.

Artwork by Mike Thompson

4 Create a new layer to use as a tracing layer, and name it Tracing.

5 Select the Sketch layer, and move the Opacity slider to 70%.
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6 Select the Tracing layer, choose another brush variant and color, and begin creating a clean line drawing based on the sketch.

Mike used a pencil from the Pencils brush category. Artwork by Mike Thompson

After you've traced your sketch, Corel Painter 2023 offers a world of creative possibilities to complete your painting.

Corel Painter 2023 | 39



Artwork by Mike Thompson

To complete this painting, Mike used fills, brushes from the Qils and Blenders brush categories, colors mixed on the Mixer Pad, and more.

You can get a more in-depth explanation of the creation of this painting or learn more about Mike Thompson.

Additional resources

You can access additional Corel Painter resources online to learn more about the product and connect with the Corel Painter community.

Resources To access

Corel Painter website http://www.painterartist.com

Corel Painter Tutorials http://www.youtube.com/user/PainterTutorials
Corel Painter on Twitter http://www.twitter.com/corelpainter

Corel Painter on Facebook http://www.facebook.com/corelpainter

For information about the products available in the Corel Painter family, visit www.corel.com.
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